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2 System Overview

With the Enterprise IP v4.2 product suite you ceEwMive or recorded video from cameras all oveuryenterprise.
Our easy to use system installs quickly and willromediately useful. The following pages will gaigiou through
the install and setup process

2.1 Software Components
The system is a robust software platform that hamiB components that are used to capture andliiever
recorded video from anywhere: the IP Server; thaildo Station; and the Web Client.

Product Suite: Enterprise IP v4.2

Client application

Live & recorded video
Centralized administration
Alarm notification

Monitor Station

Monitor Station

(2]

c

. . .

b Live & recorded video >

%_ Web Client Internet Explorer, Firefox, Safari, Chrome, &
g Opera with Optional Active -

= X-plug-in

2 Web Client
(@)

iPhone, iPad, BlackBerry, Android
Smart Phone/PDA Client Live, recorded, and PTZ control
Windows Mobile Professional

Runs as a Windows Service
Alarm Processing
Server communicates with cameras
3rd party/access control/analytics

IP Server integration
Server or camera side motion detection
Web client uses Microsoft IIS
Support for Active Directory, LDAP, and IPServer
Novell eDirectory

Monitors the IP Server and gives a visual

status on a per server basis

Allows for network connection
administration

Provides a Diagnostics version for trouble

shooting and system optimization

IP Server Manager

Server & Storage

Support for Local, Direct Attached,
SAN/NAS, and iSCSI

[ Tilh.
Pivot3 and Intransa l‘i" 1
Dell EquallLogic 4

Storage

Storage




Accessory application which monitors the
health of all of your servers and cameras
from a single location

Health Monitor

Email notification on error Health
Monitor
" Accessory application which can move S
= LTS — Long Term recordings from the server to a storage 3
= Storage location =
> Scheduled on a per camera basis LTS

2.2 Client Applications
The Video Insight Client Applications connect te ti? Server, not directly to the camera. Use tienC
Applications to view live and recorded video froreiagle or multiple servers.

Monitor Station

The Monitor Station is the primary user interfacehe product suite. From an end user point ofyieprovides
centralized viewing of live and recorded imagesrfrany server. System and Security Administratoesthe
Monitor Station to setup and configure all senaamd cameras from a central location.

Web Client

The Web Client allows you to view live or recordgdeo from anywhere using a browser including Maofb
Internet Explorer, Firefox, Chrome, or Safari. Y@an view a single camera or select up to 16 @iffecameras
from multiple servers to view simultaneously. Y@an control PTZ cameras and playback recorded vidée
system supports multiple users and is tightly irdégyl into the Windows operating system for congpéetcurity.
Supports Internet Explorer, Firefox, Safari, Chrof@eera with Optional Active X-plug-in. The webetit detects
the client used and has views specific for the ¢ybpclient used. For example, the Web client pitivide
different options when access through an iPhoranaPad or a Windows Desktop.

Smart Phone/PDA Client

iPhone, iPad, BlackBerry, Android
View live, recorded, and PTZ control
Windos Mobile Professional

2.3 Server and Storage

IP Server

The IP Server is the basic engine of the produte.sit processes and stores images received dtboonnected IP
cameras as well as streams video to the clientiéaving. The IP Server is installed on a stand&iddows based
PC and runs as a Windows service that does noiresguser login to be in operation.

The IP Server can be linked to other servers tpatfhundreds of cameras. With the software youtzve a
single server, multiple servers at one locatiomaltiple servers at multiple locations. Recordinga be stored on
local or direct attached storage, NAS, SAN, or NetwFile Servers. The software stores all settanys log entries
inside Microsoft SQL database tables. This gihessoftware a very solid platform to deliver adwethéeatures.
Most setup and configuration of servers and carmisrpsrformed using the Monitor Station.

IP Server Manager
Limited setup is performed using the IP Server Mgmdor each instance of the IP Server. The IR&Sdvlanager
performs the following functions:

Monitors the IP Server and gives a visual statua per server basis

Allows for network connection administration
Provides a Diagnostics version for trouble shooting system optimization
Manages licensing and registration




2.4 Utilities
In addition, the software also provides the follogveccessory products to assist you in managings@wers and
cameras:

Health Monitor

The Health Monitor monitors each of your serversaargular basis to ensure server uptime and tiagast any
issues affecting the servers. The Health Monitor loe configured to send email alerts to the apjatpindividual
if the server has not responded in the pre-detesaniime frame or if certain thresholds have beaeeded. The
Health Monitor status windows can also be vieweth@Monitor Station

LTS — Long Term Storage

The LTS is a standalone application that helpsrpanage your recorded video. The easy to usecapipln
connects to the video data directory allowing yoWiove, Recompress or Trim the original AVI fileShe LTS
can also recompress the original AVI file using M&oft's WMV format and is able to double the ashie storage
space. You can specify which cameras to copy, mawy days to keep before the copying and what tifitee day
to execute the copy. The new copied files cavideed Video Insight software or any Windows MeBiayer.

‘ Video Insight, Inc. | Page 10 ‘



3 Monitor Station

The Monitor Station provides three main functidihge site monitoring, viewing past history and et and
centralized administration and optimization ofdllyour IP Servers. The system is designed to bg ®ause while

having very powerful features.
3.1 Login

@ Monitor Station systern login

(=]

zemame  Jane Doe

Pazsward

[ 0k l [ Cancel l l aptions > ]

Check with your system administrator for your logiformation.
Setup and Configuration Guide.

More options can be viewed by clicking on the Opsidutton.
@ bonitor Station systemn lagin

lzerhame  Jane Doe

EEREETY

Paszward

b onitor Station syztern login options
() System Administrator mode
@ Mebwork uzer mode

Location of data file

Browse

Windowes Login

Drarmain

k. ophiong <<

H Cancel ][

See your system administrator for more informatiarOptions.

==

When the Monitor Station is initiated, a systemitogcreen appears:

For setting up users and groupsagt see the

‘ Video Insight, Inc. | Pagell ‘



3.2  Monitor Station Standard Screen Layout Overview

When you start the Monitor Station, the followirggeen appears:

© video Insight - Manitor Station

[
=]
5

Fle View Tools Administration  Help
@ o EEEEEEEEED =
LY

EREE 2 B

PTZ Controls
= |
u L}
1

-

Digtal PTZ || Joystick PTZ
Search hd

or Sear

® e O Senver O 1
There are three main sections of the screen:

Viewing Panel including the layout tool bar

[ ) e | s
[Esee ‘ el ) EERE
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Left Navigation tree structure - used to navigatef camera to camera in a hierarchical structummfserver to
camera and to view live and recorded files

IF Server -1010.5.29
gt NYE

-] FrontDoontsis
-] Front Desk [67)
Frant Droor [75]
Tech Suppart [41]
-] Kitchen [54]

o] Printers [44)

@] Hall [52)

-] Hall [53)

- Hall - 360 Wiew [51]
-m] Sales (58]

a0 Shipping (0]
8] Shipping [62)
Irventory [63)
- Back Door [59]

iz Southwest Campus
~m] 10,105,105 - Yivotek - M
oom] 101051 - s - Model
- 1010510 - Arecant - Mg
Eﬂ---EE Laypouts

[El--- Facility b aps

628 A Lapouts

B &) Facility M aps

Southwest Campus - Galleria
Southiwezt Campusz - South O
All Action lbems

< |
PTZ Controls W
P~ A |45 5]
< WP
L < A
Drigital PTZ Jostick PTZ
Search L
Enter Search String
| | [ Search ]
(® Camera ) Server O &l
Audio Controlz oy

Tool Bar - provides convenient access to commosgduools
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" File Tools  Administrakion  Help

3.3  Startup Customization

The Video Insight Enterprise IP Server providesahgity to customize what appears on startup efdyisstem. You
have several different options that may be appatgifor different users.

For instance, for users that are performing prilmdiie monitoring, you might want to configure tegstem to start
up without the left navigation tree. Additionalgach user might want to have the system staritlpanparticular
layout or facility map. To set Startup optiondeseTools from the tool bar, then select Optiontha bottom of the
list of Tools.

Swskern Log

Bis Jovyskick Conkrol
Facility Map Selector
Live Window

Media Player

PTEZ Operations

Synchronized Plaver

Opkions. .. o

When the Monitor Option screen appears, go toakeTab, Startup and the following screen appears:
On this screen, you can select a starting layatitglestandard or custom), elect to hide the ndiagaree and
launch a particular facility map on startup.

© Monitor Options fgl

General | Tool: Configuration | Live YWindow | Audio | Startup |

Starting Lapout
(%) First cameras in layout () Customn lawout

| 1 Camera Layout A |

] Hide archive tree on startup Facility map name

Launch facility map on startup | v
[ &uto upgrade

Remember layout
(#) By User [ Lock Toolhars

) Shared Layout
) Start with defaults

0Ok H Cancel ” Apply

For a more detailed description of Monitor Optioplease see section in the Appendix of this Manual.
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3.4  Viewing Panel
The viewing panel can be configured to show frora tm32 cameras in various configurations.

3.4.1 Title Bar with Layout Buttons

The layout buttons at the top of the viewing padieiw you to control the number of cameras displaye

e |l

Click on the desired layout icon, and the viewirmg@l changes to reflect the new viewing configorati

You can also create any number of custom viewssatett the layout to display on startup. To creagtom
layouts, please see the Setup and Configuratioruatafihe last two layouts are designed for wideaes or dual
monitors. The layout buttons work in conjunctioithithe navigation tree. If you selected “All Sers’eand press
the four camera layout, we will show the first 4meas. Then each time that layout is pressedllisiow the next
4 cameras. If you select a Server, it will onjgle the cameras for that server. In this way,ex aan cycle through
all of their cameras without using a custom layolit. create custom layouts, please see the Setlp an
Configuration manual.

To pause all live video in the viewing pane, select

0f

To launch the Media Play (described in a laterisagtselect

&

Aspect Ration

By default, the picture in each layout takes th&imam allowable space. However, you have the optio
preserving the proper aspect ratio. To presergitbper aspect ratio, go to Tools>Options>Gendralee aspect
ratio. If the aspect ratio is preserved, thengticture will retain the correct aspect regardlesthe size and shape
of the viewing window.

3.4.2 Function Keys

In addition to using the layout buttons in theetitlar to bring up layouts, you can use FunctionsK@&l thru F10).
By pressing F1 on your keyboard, the first layaingle pane) will appear and by pressing F2 on keyboard,
the second layout (4 panes) will appear. Use fandteys to bring up each of the 10 layouts.

The F11 function key changes the view to Full Serela Full Screen, you see only the viewing pariéd left
screen navigation or tool bars will be present.uy¥Windows tool bar at the bottom of your screeh also
disappear. To return to normal viewing after viegvin Full Screen Mode, select the resize icohatop of the
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3.4.3 Camera lmage

Each pane in the layout shows a consistent vietieofimage and supports easy to use icons and “Rilgtk”
functionality.

fieis - _ BEEELD

Title Bar

On the top of each picture, there is a Title Béhwommonly used functions.

Name of the camera — the default setting is to sth@wname of the camera in the Title Bar. Howeyeu, can
change the title bar to not show the name of tineeca by going to Tools>Options>General and dedalgthe
Show Camera Name option.

Name of the Server (optional) — By default, the aahthe server does not show on the title barwéi@r, you can
change the title bar to show the server as wetidigg to Tools>Options>General and selecting Shew& name

|:|— Turns orange if motion has occurred in the pitu€lick to reset.

=r=aii]
JI0§ Ereezes the Frame
You can also pause all live video by selectingghese button at the top of the entire viewing paméhe left of the
layout buttons.
When live video is paused, the system will not amdy display that video, it will stop streaming théleo from the
IP Server to the Monitor Station.

@[ Pops up a live window that can be repositionegiaur screen

By default, the live display in the viewing panehtinues to show video. If the user wishes to pahie main
display window when a live window launches, go twlE>Options>Live Window tab and select Pause Main
Display When Live Windows Launches. This optionuldobe helpful for people performing single taskd a
reducing the bandwidth usage.

ﬁ Replays the last 30 seconds of recorded video.
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If you want to emphasize the existence of motiothsviewing pane, you can set up the Monitor 8tatd turn the
titte bar red and flash when motion is detect&d.implement this option go to Tools>Options>Livendow and
select Flash Red on Motion.

3.4.4 Right Click on Image
By positioning the mouse on the image and rigtakatig, the following menu appears:

Full screen
Livve windomw
Live audio
Recent history

Recorded media files

Prinkt image
Save image

Send ...

Properties

Full Screen
The Full Screen option enlarges the image to ctheeentire viewing panel.

Live Window
The Live Window option creates another Window conitey the image. The user can then move that Wintdo
anywhere on the screen or another screen if meltinitors are setup.

Live Audio
The Live Audio option activates audio from that eaxen

Recent History
The Recent History option automatically displays ldest 30 seconds of recordings. If the camesatiso Motion
Only Recording, there must be motion in the lass&€onds in order for the 30 seconds of recorairtigplay.

Recorded Media Files
This option brings up the Video Player. See theudwentation on the Video Player below.

Print Image
Sends the image in the frame to the printer.

Save Image
The Save Image option brings up the Save As diagdgx and allows the user to save the current irmgdocal
or networked storage device.

Send
The Send function allows the user to send a coplyadflive viewing pane to anyone that is loggetbianother
Monitor Station. When the option is selected thibofving screen appears:
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@Send to user

Select the uzers pou want ta view this camera.
[ &l users

[] Adrmiristratar
[] pmilam
rflicl

[ Mike

[] iames

[] idee
[] Test User

()4 ] [ Cancel

You can then select the users that you want tdwedbe live view of this camera. Please note ifhigte user does
not have viewing rights to this camera, they wilt neceive the live view from the camera. In aidditonly those
users that are currently logged into the systerhredeive the live view from the camera. Whenva lvindow is
sent to a user, it will immediately popup on theireen regardless of whether they are viewing tbaitdr Station
at the time. For instance, they may be running ikorstation but have it minimized while at the satime
working on a Word document. When a live Windoweésit to them, it pops up on their screen autonibtidhyou
want to block receiving Live Popups, go to Toolst@ps>Live Window tab and check Block Live Window
Popups.

Properties
The Properties option brings up the Property arttirgs for that Camera. See the Setup and Cortigur Manual
for details on these settings.

3.4.5 Left Click to Zoom and Picture within a Picture

To zoom in on a picture, position the mouse onugeer left hand corner of the area that you wazbtam in on,
then press the left mouse button and drag the mmtesethe area to be zoomed. The system will #oem in on
the area. To zoom out, position the mouse indhet right hand corner, then press the left mous®sb and drag
the mouse back over the area. The system will toem out to the original view. You can then useRTZ
controls in the left pane to control the zoom fimetas a digital PTZ. You can click on the middfehe camera
image to return to the normal view. When you theezoom function, a picture within a picture disg in the
lower left corner. The picture without the zoorspdays in the picture within a picture with the poed area
enclosed in an orange box.

xample — Regular view

Zoomed view with picture within picture.
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You can also drag the orange box around the pittuceeate a digital PTZ control.

3.5 Left Panel Navigation Tree Structure

The Left Navigation Tree Structure provides thenmaeans of navigating between locations and cameéfas can
navigate to particular locations (servers) and casjer you can navigate to custom layouts anditianiaps. The
key elements found in the navigation tree are Ssf€@ameras, Layouts, Facility Maps and Action Iterfike
following sections discuss each element in detail.

There are three different methods for navigatingvben locations and cameras: Enterprise, Facilip$/and
Layouts.

These views can be selected by using the icorteeabp of the Left Navigation Tree Structure

Enterprise Layouts
Facility Map

3.6  Enterprise View
The Enterprise view is a server centric view. dlthe cameras are organized based off the sdraerst currently
managing that camera. In order to locate a spemifinponent, go to the server that manages thap@oemt. All
cameras, layouts, and maps associated with thagrsare located under that server. The Enterprise/Vias a
structure of

Servers

Layouts
Facility Maps
Action Items

Al Facility Maps
&)l Action [bems

3.6.1 Elements in Left Navigation Tree Structure

Servers and Cameras

The list of Servers shown in the left navigatiozetis the list of all of the servers that this jgaitr user has access
to. A server is an instance of the software wdhaus cameras attached. All Servers can be explatodinclude a
view of all servers
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®iE| S outhwest Campus
Central High School [:
i Southeaszt Campus

By selecting a particular server, all cameras ftbat server will be displayed in the viewing pane.

Each Server can then be expanded to show the caa®signed to that server as well as any layouescdity maps

assomated with that server.
- Southeast Campus

. YWest Entrance
Eazt Stainwell
Elementary School W
Cafeternia Cazh Reqist
YWest Entrance

b ain Entrance
] Pick Up area
Fm%ircle Cirive
a1l

School Bus Stop
avlz

South Entrance
Back Circle Drive
Muorth Entrance
Cafeteria

b airn Entrance
-] Main lobby
.... fuis PTZ

[=- |:||:| Layaouts

------ . e Layout
- |E| pickup

= E Facility bd aps

------ H First Floor

00 a1 zea ke

When a particular camera is selected, that cambva’siew will be displayed in the viewing pane.
Note that when a server or camera is operationelicon to the left of the name will be greenthd server or
camera is not operational, the icon will be orange.

Layouts

You can set up customized layouts that can dispdayeras from one or multiple servers.

== Layouts

e . F.ew Locations

[\LH pickup

In the example above, the administrator has sétvagustom layouts: one consisting of the Key ltimres within
the Southeast Campus and one of the Pickup arg¢he 8butheast Campus In the example above, thiedayout
“Pickup” is selected, the following view appear®sing cameras at each pickup entrance of eachddfetent
campuses
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Frant Circle Drive

South Entrance

Layouts are stored on particular servers. Howegigen the right security access, anyone on arnyesean view
any custom layout. For more details on settingugtom layouts, consult the Setup and ConfiguraBaite.

Layout Touring

The software gives you the ability to setup Laydatring wherein live images from several cameras“t@ur”
through a single pane in the layout view. Foransg, the above layout could contain pane 1 WwighSiouth Circle
Drive, pane 2 with the Main Entrance, pane 3 wiih $outh Entrance and pane 4 could contain théngyelews of
the School bus stop, the crosswalk, and the Satithos entry way. For detailed information on isgttup Layout
Touring, please consult the Setup and ConfiguraBaite.

Dynamic Layouts

You can also create dynamic layouts by selectimdragging cameras onto the viewing panes. Setgneras
from the left navigation tree and drag them i@ desired viewing panes. Cameras can be seleotadiny
server.

3.6.2  Multi-Layered Facility Map

To help locate cameras across your organizatiomcam import images of your facilities into theteys. Our easy
to use setup, allows you to take advantage off¢laiire without any customization.
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H | Display Fat:Ihty Map

Tt %
Longmant O+ i
r 3t
Y |
X ]
Dsliver Or o -
: A
. LT
5 5 iliLy
o E
o
:
e
x JE
o Baoth i
3
Thom|
il
Whalay Comer
° it e
Br:

OLung Point ok

& 20056 MapQuest, Inc ; 0 ZDDGE 2004 Map et D
If Facility maps have been set up, they WI|| appaahe Nawgatlon Tree As with layouts, facilityaps are stored

on particular servers. However, given the corsecurity access, you can view facility maps from server.
Facility maps can be layered for drill down purmos&ou can set up a map for an entire town, thiéhddwn to an
individual campus, and then drill down to an indival floor. You can set up default facility maps & server. For
instance, the default facility map for the sengkincoln.

. Fru:unt Entrance
‘ Boy's Gum
Avaditarium
Marth Stainwell
o] Adrin office
=- |:||:| Layouts
------ |E| Front Entrances
------ . Southwest Campus
Mty b aps
BEL Lincoln Campus

=

G alleria

E azt Area Campus

Frant Entrance

Gernnaziurn - Girl's

Admin Office

Marth Hall

b ain Entrance

Morth Area Campus
H-#: Bay Area Campus

-2 Al Layouts

-] A Facility Maps

By selecting the Lincoln Campus from the left naign tree, the floor plan for Lincoln High Schall appear.
You can mouse over the camera and that camera’éntimge will appear in the pane to the right. Biedlt, the
facility maps overlay the viewing panel, i.e. trag similar to a popup live window. If you wishtiave the facility
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maps integrated into the viewing panel (not a pypilne go to Tools>Options>Live Window Tab and stle
Integrated Facility Map.

(5 e o, e P ol Hido e |7 Hidle Pacity maps [ Fide leyets Oiplhere =

[ Fuecerd huscry
Comemr | HLV0S 105 - Wivotek - Macl IPT1T0
o s, | Sttt Camguan

[ vovesben. 710

] Voday, 11/7%2000

Dt Tome | i¥5200 20 | Gotallvens |
Zoom ok 4 Toomin

{

L

In the lower right hand corner is information oe ttamera, the Live Window option and the zoom ith @urt

controls. By clicking on the Recent History buttgou can review the last 30 seconds of recordingtHat camera.
Camera information

[ Live ][ Recent hiztary ]
Camera name | 10.10.5.105 - Vivotek - Model: IPF131 |

Semer name |S|:nuthwest Campus |

R

Sun Mon Tue 'Wed Thu Fri Sat
A1 2 3 4 5 E
78 9 10 11 12 13
14 [{E] 16 17 18 19 20
222 23 24 X/ X
28029 30 1 2 3 4
5 & 7 &8 9 10 1

[_IToday: 11/15/2010

Ewvent Time | 41520PM 5 | [Gutu Ewvent ]

<:| £oom aut e Foomin

5 0 E
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You can also search for specific recorded evergedan date and time.
The left arrow moves the view to the next higheiliiy map if you have set up multi-level facilimaps.

Hide cameras  Hide names -l Hide range Hide: Facility maps |E| Hide layouts  Opkions -

At the top of the facility map are options to shomremove the cameras, camera names, camera Jéagjkty
maps, and layouts from the facility map.

Change Faork. .. %
Hide Zoom Bar

Zhange font colar

You can also change the font size and color orcéineera names and remove the zoom bar from the aarigsy.

3.6.3 Health Monitor

If there are Health Monitors set up and conneatettiis Monitor Station, then the red cross icon afipear. See
the Setup and Configuration Guide for more infoiorabn Health Monitors.

3.6.4 Action ltems

Action items are essentially buttons that can bketl to initiate certain actions. In this case, ave set up two
buttons: Alert Campus Police and Alert Princip@lhen these actions are clicked, they automatiggdherate
actions such as sounding an alarm or sending ait eh@amotion event. Action Items are setup uding Rules
Manager. Please see the Setup and Configuratiade@ar more information on Action Items and thelé?u
Manager.

C e e o G

---EE All Layouts

G128 &1l Facility Maps

|£| Health Monito

EI e Action |berms
&lert Campus Police

| ®| Alert Principal

3.7 Facility Map View

When the Facility Map View is selected the treedtuire changes from the Enterprise view (Servembeid) to a
Map oriented tree

South Campus
I8 Southwest Camnpus
2B First Floar

In this case we have set up three different mapsfor the South Campus, one for the Southwest Qarapd one
for the first floor.
If you select one of the maps, then the list expandshow the cameras and the designated map appear
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S i @ Display facility map - First Floor

(. Hide cameras  Hide names <@ Hide range [%|Hide Faciity maps (28] Hide layouts  Options +

~4ca] East Stainwel
~4a] Main Entrance
] Elementary School Wing En
Elementary Sohool Wing En
Main Enlrance

Camera information

TR

Care e [ ]

Server name | Southeast Campus |

N ; ™ & Srmers. 00 b oRLE T 6 g
ST st a5 &

A E
(€] I ] B e T
PTZ Controls ¥ i
F & 9|55 Sit
< @ b @ <l m J 2
- G - | &1 &0 —

You can then use the camera icons on the map wthie image from that camera.

3.8 Layout View
When the Layout View is selected, the tree strigctivanges to a Layout oriented tree.

*-31#:".4? =10

% |28| ‘Central Office
Hotel Wiew
o] izt 7401
-] 10712

anis

EI|E| Cateteria

- gm] FO7131 - 202
-] toshiba 233
ca] 10703 - 234
I'_—'||:| Hatel Yiew

Arecont - 201

I_:_I School Bus Yard

o] 10.10.1.235 - Acti - Mode
] 10101163 - Acti - Mode
o] wiv wsF1 00 - 181

o] |gepe 712d - 400

] asis 07407 - 194

o] ais q7401 - 192

o] axis 214 - 148

-] acti 8511 - 163

IZ—J K.ey Locations - Southeast
Elementary 5choal Wing |
Frant Circle Drive

-] Cafeteria Cash Register
-] Pick Lp area

-] School Bus Stop

South Entrance

b ain Entrance

~7a Elementary School wina I[

Select the layout from the tree structure andlthaiut will appear in the viewing pane.

3.9 Right Click on Camera Name
When you right click on the camera, several optismsear.
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Live Window
Send ...

View Camera

Properties

Live Window

When you select this option, a free floating livimdow for that camera pops up. You can move orrgaléhis
image by using your mouse.

Send...

The Send function allows the user to send a copiaiflive viewing pane to anyone that is loggetbianother
Monitor Station. When the option is selected thibofving screen appears:

@Send to user

Select the uzers pou want ta view this camera.
[ &l users

[] Adrmiristratar
[] pmilam

[ﬁ rflick,
[ Mike
[] iames

[] idee
[] Test User

[ k. ] [ Cancel

You can then select the users that you want tavedbke live view of this camera. Please note ifhdie user does
not have viewing rights to this camera, they wilt receive the live view from the camera. In aiddit only those
users that are currently logged into the systerhredeive the live view from the camera.

View Camera
This option places this camera in the viewing pane.

Properties

By selecting this option, you will be taken to t@responding camera setup screens. For mord deteamera
setup, consult your Setup and Configuration Guide.
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3.10 PTZ, Search, and Audio Controls
At the bottom of the left navigation area are colstfor PTZ cameras as well as Audio Controls. cBgking on the
arrow, you collapse the controls t they mgéo appear in the left navigation area

PTZ Controls @

F o~ A EE
< WY
L v J

Digital PTZ Jopstick PTE

Search Ly
Enter Search String
| | [ Search ]
(& Camera O Server O &l
Audio Contrals Ly
Balance:
Yalume:
Drelay Buffer

37

3.10.1 PTZ Controls

With the PTZ Controls, you can control the PTZ ceartgy clicking on the arrows to move the cameriakitig on
the zoom in and zoom out buttons. When a PTZ caiseselected in the viewing panel, the PTZ coataflect the
camera that is selected.

Use Digital PTZ — When this is selected, theredsotual movement of the camera. You can alsdhesmouse
scroll wheel to control zooming.

3.10.2 Search

The Search box will assist you in locating speaificnamed cameras or servers. Enter the naneaicls. Select
the option to search just cameras, just servell.o When the Search button is clicked, the fdurbject will be
highlighted in the left navigation tree.

3.10.3 Audio Controls

Balance — Balances sound between the left and sjugrakers.
Delay Buffer — sets the size of the audio buff€his can be adjusted when you have a slow netwamkection.
Volume — sets the speaker volume.

‘ Video Insight, Inc. | Page27 ‘



4 Recorded Video

There are two ways of viewing recorded video: fithim left navigation tree and from the Media PlayEhe Media
Player provides the ability to view recordings bgtimn events and time lines and will be discusadtie next
section.

4.1 To View a Recorded File

Using the left navigation tree, double click onaanera. The view will expand to show Today, Yesigrénd
Previous Weeks. By default, expanding the viewhow recordings requires a double click. You magnge this
option to only require a single click to expand tiww by going to Tools>Options>General Tab ancetiting the
“Double Click Expands Camera”.

E-.@ Front Desk [67]
2-{] Today

----- 0 h&0m34 s
----- 10k02m07 s
----- 10k3Tm1 5
----- 10k53m1 82
----- 11 hd40mE0s
----- 12hd4m30s
----- 134 ml 3z
----- [] esterday
=B Previous WWeeks

Recorded files are organized into folders startiitt) Today. Click the folder to view the recordidds from today.
The file names represent the time when the file evaated. For example, 06h44m09s means 6:44:09R&.
system creates a new file whenever the file sizerbached the specified size (default is 200mby.tBe Setup and
Configuration Guide for instructions on changinggé settings. The file will play back in the viewasd you can
use the navigation buttons to move through the filthe system stores its files in a standard AWirfat with the
camera name, date and time stored on the file filehformat is compatible with any Windows Mediapér and
can be distributed without the requirement of aceviewer

The system automatically creates a new file at ighinregardless of size, to keep all files orgadiby date.
Depending on the amount of activity and your sg#jryou might see as few as 1 file or as many dde0for a
single day.
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When you click on a recording, a playback scredhappear with the playback options shown below.

| kgmt N%R. Sales [58]. DSh‘i_SmDQS

4 Tue Hou @9 2OU@

o &5

=] :
fi.

11/09/2010 02:43:20:351

5

Note that the software uses a progressive dowrdmaitar to YouTube. The orange bar shows the stafuhe
download. In the example above, approximately ®@%e video has been downloaded. The amouninf i
takes for the software to download the video depemdseveral factors including frame rates anduésa.

The files are downloaded as temporary files storegiour local hard drive based off of your windaemporary
folder. These temporary files are deleted dailg. change the location of the temporary foldert@@/indow
Control panel, select system, and then “Advancetesy properties”, in the System Properties appédét the
advanced tab, and then press the Environment Masialyou can then modify the User variables. défault for

Windows 7 is %USERPROFILE%\AppData\Local\Temp
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4.2  Playback Buttons

1 Frame Bac Play Forward
2,4,8,16 or 32x

I d
1 Frame "0 SPY bownload the

Play in Forwa|d Entire File Date and Time

Reverse Stamy
i " 04/02/2009 095955312
Object Search
% @l b , @— ,
/ b
Savmg a  Slide bar allows you to move /
Create

Play& Stop Clip forward or backward by
clicking on the cross bar and Clip
moving it from side to side.

4.2.1 Saving a Clip

To save a clip, open the recorded file and pres$tuse button to stop playback. Notice the ‘ialificators” under
the scroll bar. Drag the left indicator to therstd the clip and drag the right to the end of ¢lip. Once in
position, click the diskette icon to bring up tHipenenu. You can save the file to a folder oedity to a CD. If
you save to a CD, the system will give you theaptf include a Standalone Video Player with thg.cl

Thig dialog will save a portion of video, Select the file location, and press OF.
Save tofile
(%) Save tofile

Falder |E:‘\D ocuments and SettingshichardsoniMy Document| [:]

File name | TEMP_CLIP.&¥1

() SavetoCD
File Name | |

Burn the CO' when complete

[ )

[ OFK. H Cancel ]

The system stores its files in a standard AVI farmigh the camera name, date and time stored ipdatie and file
name. on the file. The file format is compatibligh any Windows Media player. Recorded files bardistributed
without the requirement of a special viewer or aagversion.

4.2.2 Save aClipon CD

After a clip has been created or a file has begadsto the CD, an information box will display dretbottom
toolbar with the message “You have files waitindpéowritten to the CD”. Click on this messagettrtsthe
process of saving a clip to the CD.

Click “Next” on the CD Writing Wizard.
Put a blank CD in the drive.
Click on the “Write these files to a CD”

The process will automatically complete. Remowe@® from the drive when the process says it is
complete.
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© CD Drive (D:)
File Edit Yiew Favorites Tools  Help

Y ) r i
cE DB D [ roders
Address €2 D1y
B S
— | Files Ready to Be Written to the CD

“_!!ritbiwriting Tasks &

(@ write these files to CD
r'j Delete temparary files

»
05hSEm0Ss

|| File and Folder Tasks

S Rename this file
[y Move this fils
[ Copy this file
&3 Pubiish this file to the Web

4.2.3 Downloading the entire file
If you need to save the entire file to a CD or olWéndows media mouse click on the

a

This action opens a Browse dialog box that youwsmnto save the file to a local computer or othedim

4.2.4 Object Search

The software includes many tools to help revievorded video. One of these tools is the smartpggad search
tool.

When the Object button is selected, the followidditional buttons appear.

Begin Object Search

And Object Search Options

From the left navigation tree, select the camarhthe day you wish to search. First select thended file from
the drop down box that you wish to search. Th&t fimage of the file will be displayed. Using tineuse, hold the
left button down and draw a box on the screen wietewant to search. Click the “Next” button. Tiile will
automatically advance to the next frame that hagement inside the box. Clicking “Next” again, adeas the file
to the next instance. Clicking the “Play” buttoiilylay the video from that point forward. Thessgm will search
from one file to another until it finds movemensiibe the box. You can adjust the sensitivity fritwe drop down
menu if it's finding too much or too little. If yoneed to abort the search, click “Cancel.”
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11/09/2010 03 43:48:333

P 18"

& =
Al fe

4.2.5 Zoom On Playback

The software provides the ability to zoom on playkbas well as live view. To zoom in on a pictysesition the
mouse on the upper left hand corner of the ardaythawant to zoom in on, then press the left mdugéon and
drag the mouse over the area to be zoomed. Thensyseill then zoom in on the area. To zoom ousifion the
mouse in the lower right hand corner, then presdeft mouse button and drag the mouse back oeeartba. The
system will then zoom out to the original view. Ycan then use the PTZ controls in the left pareotdrol the
zoom function as a digital PTZ. You can click be middle of the camera image to return to the abrriew.
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4.2.6 Object Zoom and Print
In the upper right corner of the playback windowvaisicon for-Qhject Zoom
q

[ Southeast Campus. Bus Fickup. 00h0Tm0Es
- s
{

I \ % a

| Pa 8
| ™

When you click on the Object Zoom the playback pawmnd a new window appears.

(@ objectzoom ""_[__][g]#

Using the Object Zoom, you can save the currengéna
Increase or decrease the size of the Window
D] 2|

Or Print the current image in the window.

You can also use the zoom function described abh@vdeft click on the area to be zoomed.
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4.3 Media Player

You may also use the Media Player to view recordddo. The Media Player provides the ability towie
recordings by motion events and time lines. Taasdhe Media Player, Select Tools from the topliapand then
select Media Player

l’% Syskem Log

Bis Jovyskick, Conkrol
Facility Map Selector
Live Window

Media Player

FTZ erations

Synchronized Plaver

Opkions. ..

Recorded files are organized into folders startiith Today. Click the folder to view the record@ds from today.
The file names represent the time when the file evaated. For example, 06h44m09s means 6:44:09A&.
system creates a new file whenever the file sizerbached the specified size (default is 200mb®.tBe Setup and
Configuration Guide for instructions on changingdé settings. The file will play back in the vievaed you can
use the navigation buttons to move through the filthe system stores its files in a standard AWirfat with the
camera name, date and time stored on the file filehformat is compatible with any Windows Mediapér and
can be distributed without the requirement of aEeviewer

The system automatically creates a new file at iglitnregardless of size, to keep all files orgadiby date.
Depending on the amount of activity and your sg#jryou might see as few as 1 file or as many dde0for a
single day.
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The Media Player’s screen layout has the followsagtions:
Selection panel which determines what recordirgaged
Viewing panel (Playback panel)

Tool Bar

Browse Viden Servers : '@@

Browse Folders for Yideo
. 0 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16 17 18 19 20 21 22 23
Buick Select bl | | 5 5 S S| 0 | | | E

Server | tamt NYE b | E

Camera | FrontDooitwis 10.105.233) |+ |

Drate

Sun Mon TueWed Thu Fri Sat

711 2 3 4 5 &
78 9 10 1 12 13
14 B 16 17 18 19 20
2102 23 24 2% X%/ X
2029 30 1 2 3 4
5 B 7 8 9 10 11
[ IToday: 1141572010

Load Timeline

Lazt event before specific time

[20rmmem 2| P |

1141172010 11:02:39

Motion Events # »D @
—

Flayer Cantrals h A

4.3.1 Selection Panel

There are four ways to select video recording tplaged
- Browse Video Servers

Browse Folders for Video
Quick Select

Motion Events

Player Controls

Use the down and up arrows to select the option.
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Browse Video Servers
The Browse Video Server option uses a tree straatansisting of servers, cameras, and dates

Browse Video Servers

FrontD oordsis

=8 Front Desk [67)

ER ] o |

----- 01 h&0m34s

----- 1 0hD8m07 s

----- 10k 1 53

----- 10kG3m1 83

----- 11hd0mE0s

----- 12hd4m30s

----- 13hd7m1 33

----- || “esterday

B[] Prewvious Weeks

Frant Droar [75]

Tech Suppart [41]

£ Kitchen [64)

) Printers [44]

@) Hall [52)

@) Hall [53)

-l Hall - 360 Yisw [E1)

@] Sales [59)

@) Shipping [60)

@) Shipping [62)

[Freemtbony B3]

@) Back Door [59)

i Southwest Campus

@ 10.10.5.105 - Vivotek - Model: IP7131
] 101051 - duis - Model: 2238
1010510 - Arecont - Model: AW5105

Navigate to the desired server, camera, date,ianedtd select the recorded video to be played.
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When you click on a recording, a playback scredhappear with the playback options shown below.

1 [ ||

E Marmt NYR. Front Desk (67). E:AWIDEONI010.5.237 137622403541 1.15. 201041 0h03rm07 2. avi

17:29:40 2000/09/22

o7 111542010 10:09:13
N 55

The playback window functions in the same mannetessribed above.
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Browse Folders for Video

*Erowse Folders for Video L
Foot Directory |E:"~ |
B[] EM

----- ] 4.0Recordings

----- ] Analog_Recordings

----- ] Archives

----- [ cli4B00pciBwinkap

----- ] Docurnents and Settings

----- ] Drivers
----- ] Inetpub
----- ] IPRecordings

----- ] Hain Office

----- ] MS0Cache

----- [] Program Files

----- ] RECYCLER

----- [ Swstern Walume [nformation
B[] wideo

EE‘ 10.10.1.158-701 78500
- ] 02.14.2008

----- ] 10.10.1.221-36407 3570
=-[] 10.10.1.230-12745331 57
=-{_] 02.14.2008

----- [ ] 10.10.1.230-187635320
----- []10.10.1.230-263527619
----- ] wWINDOWS

Using this option, you can browse folders directtythe server or other servers attached to theanktwi his
option does not use the streaming to the Monitati&@t to play recorded video. Note that in orbeplay video
through this option, you must have the correct COstalled on your computer.
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Quick Select
Using this option you can select recordings based calendar and timeline.
Quick Select kg

Server |Mgmt MYR vl

Camera |FronlDonrA:<is [10.10.5.233] vl

R

Sun Mon Tue 'wed Thu Fri Sat
31 2 3 4 5 E
78 3 10 EWiz 13
14 5] 16 17 12 19 20
222 2 oM 2\
2 029 M 1 2 3 4
5 6 7 8 3 10 N
[ IToday: 114152010

Load Timeline

Lazt event before zpecific time

Date

[ 21822pM 3| Py |

Select the Server and the Camera

Select the day from the calendar.

You then have the option of Loading the Timelinewi If this is selected, the timeline will app&athe top of the
viewing panel. The Timeline chart is a graphiegiresentation of where motion occurred throughoeitiay.

001 & 03 04 05 06 07 08 09 10 11 12 13 14 16 16 17 18 19 20 21 22 23
IIIIIIIIIIIIIIIIIIIIIII

L]

By clicking on the orange lines, the system wliflypthat piece of video. It's a great tool for ckly reviewing the
previous day’s video. You can also zoom in ontitmeline chart by selecting the “+” button on thghi.

If you prefer, you can select the day and thenguie time box, select the time and click on theeyRiutton. The
last motion event prior to that time will play inet viewing panel. Click on the Save Clip buttomtickly save a
clip of that motion event. Click on Download, towhload the entire recording.
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Motion Events

Motion Events o
Server |Mgmt HYR v| [ Feload l
Camera |.~’-\II Cameras v| [ Advanced ]
Day Tirme Camera -~

11.11.10 10:55 &M M

11.11.10 11:01 &M
11.11.10% 10:59 &k
11.11.10 11:00 &AM
11.11.10 11:00 &AM

10h55m1Es  Kitchen [B4)
10hd2m34s | Front Desk [67
DahdEmd7s | Hall [52]
04hdBmdds | Front Door (75
10hd2m34z | Front Desk [67

SRR -

11.11.10 171:00 &k 7 [04hdbmd3s | FrontDoordxiz
11.11.10 17:00 Akd 0 | 10h38mBEGBz | Tech Support
11.11.10 10:53 Akd 0 [04hdEmd8s  |Hall (53]
11.11.10 10:59 &M 10 10kd2m34s | Front Desk (67
11.11.10 10:59 Ak 0 [04hdEmdds | Front Door (75
11.11.10 1053 &M 5 | D4h4Bmd3s | FrontDoordsiz
11.11.10 10:59 & 5 [10hd2m3ds | Front Desk (67
11.11.10 10:59 &k 0 |04hdbmdBs: | Hall (53]
11.11.10 10:53 &k 0 [04hdEmd7s |Hall [52]
11.11.10 10:58 Ak 4 [10hd2m34s | Front Desk (67
11.11.10 10:58 Ak 0 [04hdEmd?s | Printers (44]
11.11.10 10:58 &k 4 [10hd2m34s | Front Desk 67
11.11.10 10:58 Ak 0 [04hdEmd7s  |Hall (52]
11.11.10 10:58 &M 8 | 10hd2m34s | Frant Desk (87

The Motion Event Log is a very powerful tool thélbas you to rapidly review recorded events. Thstem
creates an entry that includes the camera name,and duration each time a camera detects mokonexample,
if you review the video in the morning from the yimus night, you can start by looking at the MotEewvent Log.
Select the camera and the date desired. Clickingnoentry plays just that piece of the video amdgyou a quick
shapshot of the night's events. The Motion Everyj tan keep as many days of history as you fewésssary and
all entries are stored in the Microsoft SQL databagou can enable the Motion Event Log by accestlie Server
and selecting the Setup/Server Configuration/Adedritab. The system also gives you the capabditsitiel
events (event tags). You can set up a specifintestech as Door Open that reflects a specific magient rather
than just motion on a camera. For instance, youseaup an event label called Door Open. Whenethent
occurs, an entry in the event log shows that laBskent labels are set up under Setup and Configafa&Camera
Configuration, Motion Settings.

Select the Server that you are interested in.

Then select All cameras or a single camera.

Then click on the Reload button and the motion &sveiill appear.

For advanced searching functionality, click on Aekvanced button and the following dialogue box apen
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tdation Events o

Server |Mgmt MR V|[ Reload

Cameras [ FrontDoodeiz [10.10.85.233] A Basic
[] Front Desk [67) (10.10.5.231]
[ Front Door (751 (10.10.5.232]
[] Tech Support (41)(10.10.5.24
[ Kitchen [64] (10105.238] & | | Select 41

[ Minimum M otion I:I 4

Resztrct Times

[ MotBefore | 11452000 v || 24504PM %
O] Metditer | 11482000 v || z4E04PM %

You can then refine your search to multiple caméoathat server, motion events with greater thagercent
motion and for specific times.

4.3.2 Media Player Tool Bar

Decrease
playback size

|
] 08 @ e e

Single Motion
Player Evert Increase playback
size
Timeline Open
View File

The tool bar on the Media Player presents icongh@reasy navigation between various ways of datpct
recordings to be viewed as well as zoom in andundtionality.

Single Player
When the Single Player icon is selected, the Brawaders for Video selection option appears ingblection
panel to the left. Click on the file to be played.

Timeline View
When the Timeline View icon is selected, the Quic8elect option appears in the selection panel on theft.
Click on the day and then select the time from thémeline chart.

Motion Events
When the Motion Events icon is selected the Mofiwent option appears in the selection on the I8#lect the
Motion event that you want to view.

Open File

Increase/Decrease Playback size
This option increases or decreases the size ofi¢héng panel for playback

Magnify Current Image and Print
When you click on the Magnify Current Image a neindew appears.
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Using the Object Zoom, you can save the currengéna

Increase or decrease the size of the Window
D] 2|

Or Print the current image in the window.

You can also use the zoom function described abh@vdeft click on the area to be zoomed.
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5 Pull Down Menus

File  Wiew  Tools  Administration  Help

5.1 File
&:\k Media Fixer
Exit

5.1.1 Media Fixer

If the server is shut down unexpectedly due tovagumutage or other situations that correct a viilepyou can
repair the damage with the Video Fixer. This gtiixamines the file and deletes any corruptedqustthat
prevent the file from playing.

To fix a file:
Click the “Open File” button to select the filelte repaired.
You can use the Remove file or Remove all filegdyut
Once the file has been specified, click the Fixdiuto start the process. This function is foirixa file
on the local system. If you want to fix the file the server, you should right click on that faed the
video server will perform the media fixing.

=lolx|
TE——T:  -tiiCEPAEEE—BIH_———A—A—_—_

Ywivcam0T403.71. 200541 2h30m43s.avi

YwihcamO5h03.05. 200541 3h09mE7s.avi

YwivcamOTA03.07. 200541 5h19m33s.avi

Nitcam04h03. 07, 2005A00h085md 5. avi

Cohvitoam04h03. 10, 20054 3h27mE3s. avi
Femove File

Start ko fixC:hvitcamCT 40311, 20054 2h30md 3. awi
Viden 22416 frames was recoversd
i s Finish fixing at: C:\vibcam01403.11.200541 2h30md3sfised. avi

|

1 files] have been fized
1 file[2] have been failed

open 2l
Look in: |3 03.11.2005 | emerE-

| O0hi4mizs  avi
| 10h22mzds avi
L3 1 1hazmzas avi
5] 1 2ha0meds avi
2] 13h40ma3s v
] 14h39m3s v

File name | =l dpen |
Files of typs: IAVI files [%.441) =l Cancel i
ﬂ

5.1.2 Exit
Exits the application
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5.2 View

EI Left Panel
Full Screen F11
Layauk [
Layout Order
Mini Toolbars 3
Status ¥
Toolbars 3

The View Pull Down menu presents an easy to usengiea choosing to display or not display varioast®ns of
the screen.

5.2.1 Left Panel

To remove the left panel from the display, unchibekLeft Panel option. After this has been uncheclonly the
camera views will display.

5.2.2 Full Screen

You can maximize the viewing area by clicking omflFScreen” or hitting the F11 key (exit full serewith F11).
This mode will expand the images to full screedehhe left navigation tree and hide the tool ba@nce in this
mode, you can navigate between the layouts by ubm&1-F10 keys. By enabling security you cavent users
from exiting the full screen mode.

5.2.3 Layout

Using the Layout option under View is another whgealecting the layout of the cameras on the vigveicreen.
This option also shows the function keys that camised to toggle between layouts.

Left Panel

Full Screen F11

Layout [ 4 1 Camera Lavout Fl
Lavout Qrder Fz

4 Carnera Layaut

Mini Toalbars 3 & Camera Layout F3
Status » 9 Camera Layout F4
Toolbars ¥ 10 Cameta Lavout F5

13 Camera Layout F&

13 Camera Layout - 2 F7

16 Camera Layout Fs
25 Camera Layouk Fa
32 Camera Layouk Fi0

5.2.4 Layout Order
This option displays the order of the cameras éwrious 1, 4, 16, and 32 camera layouts.
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& Camera Layout View

4 Camera Layout

5.2.5 Mini Toolbars

Left Panel
Full Screen F11
Layauk [
Layout Order
rlini Toolbars . » | Cycle Lavouts
Skatus A k Ptz Conkrols
Toolbars 3

Cycle Layouts

EE = (=) o

This feature turfrs-6n the automatic cycling. Wties is activated the server will cycle betweerB&licameras via
1, 4, or 9 camera layout.

You can also create your own customized layoutgyoling by selecting the button on the right @rtin red.
Clicking on the arrow will begin the cycling. Yaan turn off the cycling by clicking on the box.

PTZ Control

I‘B I ! = qEW EEITIEI‘E |

[F ~ 3|85
< @ ¥
L ~ g

‘ Video Insight, Inc. | Page 45 ‘



- % ‘ Cycle through all PTZ cameras

. Cycles through the presets on that camera

ER - Stops movement

The options shown on the PTZ controls depend ospleeific camera. For example, if the camera doésupport
focusing, those buttons will be hidden.

5.2.6 Status
Left Panel
Full Screen Fii
Layaut 3
Layout Order
Mini Toolbars 3
Status 3 | Server Status
Toolbars 3

When Server Status in turned on, then the statali eérvers appears at the bottom of the viewaugep

5.2.7 Toolbars

Left Panel

Full Screen Fii1

Layout 3
Layout Order

Mini Toolbars 3

Skatus 3

Toolbars M » | Layouts
. Loagin
Widescreen Layvouts

Use these options to remove layout buttons fronstneen. If you do not wish to show the login idre current
user at the upper left hand corner of the left paoen the login option off.

5.3 Tools
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’% Syskem Log

Bis Jovyskick, Conkrol
Facility Map Selector
Live Window

Media Player

PTEZ Operations
Synchronized Plaver

Opkions. ..

5.3.1 System Log

The System Log allows you to view all system evémds have occurred. The Date and Time of the@aas well
as the Message is shown. System events includeofathe details of what changed on cameras angrseas well
as server shutdown.

(=] System Log Viewer |Z"E|rzl

2/18/2008 1:55 14 PH The operation has lined out.
2/15/2008 12308 PM [ The operation has timed out

2/18/2008 125801 PH The operaiion has timed out.

/08 123754 P " The operation has fimed aut

2/18/2008 11.57:47 A The operalion has timed out.

21B/2008 11 2741 A4 " The operation has fimed

21B/2008 105734 A The operaiion has fimed ot

2/18/2008 104851 A4 bdminisuator has logged in at 10:48 AM - 2/18/2008

2162008 10,3638 A " inisroton s Ingged in at 10736 AM - 2/16/2008

241842008 10,27.26 &M The aperation has fimed out o

2/15/2008 35714 40 I

2/18/2008 955,08 AM The operation has timed out.

271842005 8 55,00 Ak [ The operation has timed out

2418/2008 32710 4M | The operstion has timed out

2/18/2008 324:53 &M 1 The D;)Evahun has timed out.

21BA05 52453 AM The operation has fimed ot

2/18/2008 557,07 AM The operalion has timed out

205 654,37 AW " The operation hes fimed aut

2/18/2008 554,37 &M | The speration has imed act ™
Server | CERIERTD

5.3.2 Axis Joystick Control
This option links to the standalone executablgtierAxis Joystick. You can then use the joystrkiove the PTZ.
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X

Axis Joystick Support

Az Jopstick support

llzemame |r00t |
s |

Pazzword

Current Carnera LIRL
(it /#10.10.1.201 fuser/cgivbindview_5_t_uF timl |

Button Controlz

Presz button to zelect an P camera

Preset 1 [ 1 ][ 2 | Preserz |

Freset 3 |[3][4]
| s JleJ ]
| | ER R
| Lo J o]

[ Config H Settings H Save H Exit ]

5.3.3 Live Window

When Live Window is selected, a new window willdygened. You can select the camera to be viewednawve
the window around the screen or across multipleitom

5.3.4 PTZ Operations

You can control Pan-Tilt-Zoom cameras from the MonStation or Web Client These controls allow youmove
the camera in all directions and save preset loeatior quick access. In addition, you can cylsfeugh presets in
a specified interval. This cycling can be started stopped from the Monitor Station and the Welei@li You can
setup up to 16 PTZ cameras per server under thp/S=tmeras/PTZ setup screen and all 16 cameraseceycled.
If you manually move a cycling camera, the cychvii pause for 30 seconds then resume the presés.cy

© PTZ Operations

Camera Select FTZ Controlz Presets | Cycle Fresets
Server
i
| Southwest Area Campus b | </\ l__L| EI EI ‘ E[D:slé?g (it
Camera Q J » EI preset3 Delete
[ Gymnasium PTZ (10.10.1.20 + | L <
\/

5.3.5 Synchronized Playback

With the Synchronized Playback function you caniedh perfect playback of recorded files betweend 56
cameras. When Synchronized Playback is selectéat, fhhe system to the correct folder with the widem the
cameras to be displayed. Once the folder is slethe following screen appears:
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—
&) Multi-Carnera Synchronized Player

Root Falder [where video is stared)
Cihvideo

Cameras tl
C:'wideot10.10.1.1 35166097
[] Chwideot10.10.5.1-21341059
[] Chwideot10.10.5.1-46912214
[] Chwideoh10.10.5.10-9477645
Chwideot10.10.5.231-205519
CAwideo10.10.5.233-865513

Date
Tuesday . MNov 16, 201 -

Available Video

=
=
o

=|

=

=
)

)

Y
£

5]
=

T
i

4> 00 > pp
I

Select the desired folder of video recordings, thelect the cameras to be viewed.

Select the date of the recordings. Once the daidden selected, a time line appears with an itidicaf times of
motion for each camera. To select a time framgdw, move your cursor along the time line, anchtledt click
and drag the cursor to highlight the time framethinexample below, the time between 12 noon aRi 2vill be
viewed.
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D ate
Tugzday . Mov 1B, 201 -

Time Availlable Video
[1]

4
, -

12

18

20

24

K4l 00> b

Once the time frame has been selected, selectahdoptton at the bottom of the screen. The systdhbegin the
synchronous display of the selected cameras. &lstethat at the bottom of the picture, theretisne line as well,
This is a detailed time line of the period seledtedh the Time frame on the left. Note also thati gan drag the
pointer to anywhere along the time line. )

(®) Wulti-Carmnera Synchronized Player

HFIUI Folder [where video is sluled]r

Chvideo
Cameras I:I
(7] C'widenot10.10.1.135- 166097
[7] Crwideot10.10.5.1-21341053
[[] C:wideo®10.10.5.1-46912214
(7] Ciwideat10.10.5.10-9477645
[V] C'widenot10.10.5.231-205519
EC iE

Date
Tuesday . Mov1E, 2001 -

Time Awailable Video
T
¢ Je— 4
12—
6
0—|
FrE—
£ o,
LN |
A= 00 1> t+—) .
S a—
TAB/2000r08a0sE2 ]

‘ Video Insight, Inc. | Page50 ‘



5.3.6 Media Player
See description of Media Player above.

5.3.7 Options
See the description of the Monitor Options in tle¢up and Configuration Guide.

5.4  Administration
The Administration tab is discussed in the Setup@anfiguration User Guide.

5.5 Help
b

License Agreernent
Online IP Address
Cnline Suppark
Remaokte Suppork

About Yideo Insight

5.5.1 License Agreement

This option links to the License Agreement. Wheftvgare is first installed, the terms of the agreatmmust be
accepted.

5.5.2 Online IP address
Looks up your current external IP address.

5.5.3 Online Support
Brings up a pdf of the documentation

5.5.4 Remote Support

The Remote Support option sets up a connectiohagdrechnical support can make a VNC connectianyour
server. Before making a connection, please calhfieal Support at 713 621 9779. They will indécaihich
support line to use.

Wideo Insight SC

Support 1

Suppaort 2 V I

Suppart 3 IDEO NSI@HT
Suppart & Tech Support

Suppart 5
Suppart &
Suppart 7
Suppart 8
Suppart 3
Suppart 10
Suppart 11
Suppart 12

Double Click to make a connection Video Insight DWR Support

Before making a connection

Mare Info CLOSE

5.5.5 About Video Insight
The Video Insight About shows the current versiod the location of the executable files.
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[ About Video Insight s =

Maonitor Station

Yideo Inzight
All rights reserved.

Yersion: 4.2.0.24
Language: Englizh [United Statez)

Executed from:
C:\Program FilesW1 Enterprize’h onitor StationtonitorS tation, e

Wwarning: Thiz computer program iz protected by copuright law
and internationional treaties.

Thiz product iz licenzed. Unauthorized reproduction or
distribution of this pragram, or any portion of it, may result in
zevere civil and criminal penaltisz, and will be prozecuted to the
maximum extent pozzible under the law.

Technical Support [nformation
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6 Web Client

The Web Client provides the basic functionalityttef Monitor Station without having to install addital software
on a remote computer. Users can view camerastnaltiple servers at the same time and view recoxdgeb
from any of the cameras. PTZ control, map-baseihation, and continuous playback of recorded vigealso
supported.

The Web Client will work on operating systems thapport traditional web browsing, including Micrdtso
Windows, Mac OS X, and Linux.

The Web Client is compatible with most modern wedsers. The browser must support javascript a@ve: h
javascript enabled. Supported browsers include:
Microsoft Internet Explorer 7 or higher

Mozilla Firefox
Apple Safari
Opera

Google Chrome

6.1 Accessing the Web Client
To access the Web Client, navigate your browséttm//<your IP- Address>//videoinsight4
You will see a login screen if security has beeabded, or you will see the default camera view.

6.2 Login Screen
If security has been enabled, you will see a legieen

web client login
enter your user name and password to log in.

user name: |JaneDos
password: TITTTIIL]

profile: Intranet |E|

Enter your username and password and click Logaotdinue.
Note: If your system is configured to use Activiee@tory, you can login using your standard netwlodin, e.g.
mycorp\janedoe.

Profile — The Profile option allows you to choageich profile to use when accessing the Web Clidritis is used
primarily when you are accessing the system oweirtternet or when you need to limit how much baiddlvyou
use for video. For example, you may have an ietraser profile that permits high speed video avkrcal area
network and an internet user profile that limitdeo frame rates for use on slower internet conmestiyou are
using the web client from. Choose the Profile fritve drop down list.

6.3  Screen Layout

‘ Video Insight, Inc. | Page53 ‘



VIDEO INSIGHT WS CLIENT

Enterprize Directory | Layout | BestFit i (] High Speed Wode
B

Elemental ool Wing Entrance Cafeteria Cash Register

Maps | v Live | Events | Help User: Guest Log Out

i D West Entrance
- [y cafsteria

I D Elementary School Entran
- [yn|cafsteria Cash Register
- [y aEast Stairwel

- [yn] Elementary School W
I D Main Entrance

I D Front Circle Drive
I D Main Entrance
+ [yn| cafsteria Checkout
- (] Main lobby

| I D["u'l Court yard

< I 1l ] m

Pan Tit Zoom b4

St
[l
o0

Presetz Cycle

| Mo v

There are two main sections of the scr
Left Navigation tree structure which can be usedaweigate from camera to camera and to view rect
files.

Viewing Panel

6.3.1 Left Navigation Tree Structure

The Left Navigation Tree Structure on the Web Glfemctions in a manner very similar to the Monigiation.
Just above the navigation tree structure are thp&ens for sorting the tre

Enterprise View -orders the navigation tree based oner hierarchy. You can view the cameras, layc
and facility maps for each server.

@ Facility View —orders the navigation tree based on a facilityanry. This view lists all of the cameras ¢
layouts for each facility map.

Layout View — ordershe navigation tree based on a layout hierarchyis View lists all of the cameras f
each layout.

The navigation panel can be minimized or expandedibking the button located along the right haidk of the
tree. See circle above.
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6.3.2 Enterprise View
|Errterprise Directary v] @ n G

=1 5] Al Servers
o[
[y o) FrontDoor Axis
[y Front Desk (67
[y Front Door (75)
[y Tech Support (41)
[y ) Kitchen (54)
[y ) Prirters (44)
[ Hall (52
Ci.a|Hall (53)
[y Hall - 360 Wiew (61
i .a) Sales (58) E
(") Shipping (500
[y ) Shipping (62)
|:| Invertary (53)
[y Back Door (59)
EE Layouts
Facility Maps
A1 Facility Maps
EH &l Layouts

Pan Titt Zoom

n[t]e]
e [= =]
Qoo

L1

Presets Cycle
w| o Off b

Under this view, a listing of all servers, cametagouts and facility maps is shown.
From the list of the cameras, maps or layouts,sgdect the cameras that you wish to appear in tbeidg Pane.
You may also select a layout or a facility map.

6.3.3 Facility Map View

As with the Monitor Station, you can also selee Bacility Map view. Once you select a facility pnghe map
appears in the viewing pane. You can mouse o¥ecdimera icons on the maps to view live images frah
camera.
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Facility Directory [> ) @ 55 | racility Map Layout | ¥ | [ High Speed Mode
=
O ¢ o Tech Support (43)
L] @ FrontDoorAxis
[ {a/ Hall (52)
[ { o] Sales (58)
O ¢ o] Front Desk (67)

Pan Tilt Zoom FIRST FLOOR

43

6.3.4 Layout View

The Layout View brings up the list of predefinegidats. Select the layout from the tree displagslélyout on the
right hand side of the screen. You may also séhelividual cameras from each layout, or mix andahanultiple
layouts and cameras by checking the box next tb gam.

| Layout Directory | 7] @ * Hallways Layout | Best Fit | '] [®) High Speed Mode

[=] All Layouts
EREIRE Halvays|
O ¢ ) Printers (44)
O ¢ ) Shipping (62)
O ¢ | Hall (52)
O ¢ | Hall (53)
2 m HB Patsy

L Pan Tilt Zoom

‘ Video Insight, Inc. | Page56 ‘



6.3.5 PTZ Control
Selecting a pan/tilt/zoom enabled camera from thegation tree automatically expands the PTZ Cdpanel.
Alternately, you may expand or minimize the panetlicking the double arrows at the lower right taside of the

navigation tree.

44

Pan Titt Zoom

n[t]2]
=[5 E == )
mmm (— Shutter +:]

Prezetz Cycle

| Mot |v]

Predefined camera presets are listed in the Présgisdown list. See your system administratorceoming these
presets. The cycle option allows you to cycle tigto presets on the selected camera.

6.4  Viewing Panel
Once you have selected the cameras or layoutstfrereft navigation tree, the images from thosearamwill

appear in the Viewing Pane

Southeast Campus » Key Locations - Southeast » Custom Selection Layout | BestFi Ik (] Enable Streaming

hool Bus Stop

Front Circle Drive Main Entrance South Entrance
i o

feteria Cash Register

6.4.1 Layout Option
The Layout drop down list allows you to changeltyout for viewing camera images. You can choaseaf the
predefined camera layouts, or let the system auioatly display the optimum layout by selecting “Bé-it”.
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6.4.2 High Speed Mode

Checking this box enables high-speed video stregumiour browser. This option requires Microdaotiernet
Explorer and a one time install of the Video Streamtrol. Once installed, you will be able to vie#PEG4 and
H.264 video in your browser.

To install the Video Stream Control
1. Using Internet Explorer to view the Web Clientiese a server or camera from the navigation tree.

2. Check the High Speed Mode box in the panel head¢rlpove the video.
3. You will be prompted to install the Vide Stream @oh Depending on what version of IE you are gsin
the following screen appears:

VIDEO INSIGHT Wes Cuent  Maps | b Live | Ewents | Hslp User: Guest  Leg Out

[Emerplsa Drsctory | v @ w o Layout (@) High Speed Mode
B ] A servers @ Click here to instal the following ActiveX control: “Videe Stream Contrel from "Video Insight, Inc....
A c-ror)
[ Front Door
[ { @) Tech Support
[~ ¢ Sales
I~ ] VE.GNN
HH Layouts
Faciity Maps
1|62 (E A Facay msps
HE An Layouts

Pan Tit Zoom This website wants to install the following add-on: "Wideo Strearn Control' from ideo Insight, Inc.'.  “hat's the risk? Install

4. Click Install and wait while the software installslote: If video does not appear after a few sdsptry
clicking “Refresh” on your browser. You will seeh speed video after the installation completes.

‘ Video Insight, Inc. | Page58 ‘



6.5 Web Client Tool Bar

WER CLIENT Maps | » Live | Events | Help

6.5.1 Live View

When the web client is first opened, this Tool Bét be set to Live. When Live is selected, thenesa images in
the Viewing Pane are live images.

6.5.2 Maps

When the Maps Option is selected, only the Facitigps will appear on the web client. The left gation bar will
disappear.

VIDEO 1NS[§HT WER CLIENT * Maps | Live | Events | Help

(— R P

Ehmentary SEH&QL" g Entrance
o

~=3r : 1 ~ T~
ORI = e £x HIBITION CINTRE
T S 5 . ? ENTRANLE

: /]\“:J/"“/ -~ o /

as - €] £
== Easp2tainvell
\.\

6.5.3 Events

Clicking the Events link in the menu bar will takeu to the Events Screen. The Events screen aljowso replay
recorded images from cameras. The navigationidrsienilar to the Live screen and gives you theéaypto select
camera recordings via the Enterprise, Facility,ayout View.

There are two sections of the Events panel: thadta Selector and the Events.
The top pane is used to select the cameras ordiagsr Once the camera has been selected, dededesired date
and a list of events for that date appear.
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Enterprise Directory | q [@] n ]

= ZJ All Servers 4

= = | Mgmt NVR
(+] FrontDoorAxis
E’ w:] Front Desk (67)
Front Doar (75) _—
Tech Support (41)
Tech Support (43)
(4] ( | Kichen (64)
Printers (44)
— sas

Events (Front Desk () 11/16/2010 | 1] 2

<] 11am 4 events
11:10:37 AM 27 sec
11:12:00 AM 13 sec
11:17:45 AM Ssec
11:18:10 AM 13 sec

To view recorded video select the individual redogd.
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The selected recording video will appear in thewiiigy Pane.
The playback controls will depend on whether Stiegs enabled. If streaming is not enabled, thamplified
playback control appears.

G

To create a clip, click on the Clip icon and set tlip indicators to the portion of the recordihgttyou want to
save. Then click on the Download Clip Icon.

The following dialog box will appear:
File Download 3

Do _l,mU[:gant to open or save this file?

@ Mame: tmpC,avi
Type: Video Clip, 52.9MB

From: 10.10.1.50

Open ] [ Save ] [ Cancel

|--' ‘whhile files from the Internet can be uzeful, some files can potentially
harm vour computer. If you do nat trugt the zource, do not open or
= zave this file, \Whal's the sk

Save the clip to the desired media or directory.

If Streaming is Enabled, then the more robust altrontrols appear.
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These controls function in exactly the same maasdhe Playback controls in the Monitor Statioeri

Zoom on Playback — Available only when streaming idisabled

The software provides the ability to zoom on plagjbas well as live view. To zoom in on a pictyvesition the
mouse on the upper left hand corner of the ardaythawant to zoom in on, then press the left mdusgton and
drag the mouse over the area to be zoomed. Thensysell then zoom in on the area. To zoom ousifion the
mouse in the lower right hand corner, then presdetft mouse button and drag the mouse back oeeartba. The
system will then zoom out to the original view.

Saving a Clip

To save a clip, open the recorded file and pres$tuse button to stop playback. Notice the ‘ialificators” under
the scroll bar. Drag the left indicator to therstd the clip and drag the right to the end of ¢tlip. Once in
position, click the diskette icon to bring up tHipenenu. You can save the file to a folder oedity to a CD. If
you save to a CD, the system will give you theaptf include a Standalone Video Player with the.cl

6.6 Help
In the upper right hand corner of the web clieewwis the Help option.

Settings | Help

Location Setup %

License Agreement

Help on the Web
User Manual (PDF)
Abaout

6.6.1 Location (Profile) Setup
See your system administrator for information aratmns

6.6.2 License Agreement

This option links to the Video Insight License Agmneent. When Video Insight is first installed, thems of the
agreement must be accepted.

6.6.3 Help on the web

This option links to the Video Insight Support pagd hese pages offer helpful tips and answenetpuéntly asked
guestions.

6.6.4 User Manual
This option links to the User Manual in PDF formathe manual can be viewed online or printed faarlaeference.
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6.6.5 About Video Insight

The Video Insight About shows the version, modehbar, and serial number for the product. It alsonss the
dates that technical support will no longer be latde as well as the dates after which no prodpgtades will be

available. In addition it shows the Name and Compthat are licensed to use this product and thieoaized
phone number. This phone number must be referembhed calling for technical support
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7 PDA Client

As with the Web Client, the PDA client is supportesdmost modern javascript enable handheld browSéis
includes iPod, Blackberry, and many others. To s&tlee PDA client, navigate your handheld devibetsvser to
the same address that you use for the Web cligme. system will automatically detect if you haveupported
device and will format the display for your screen.

The video will now smoothly display giving you thbility to select different cameras, and perfornrZRdmmands
from your mobile device.

i AT&T 3G 3:01 PM 3 -

" Directory

Front Door

©

Tech Support

©

Sales

©

VE_CNN

©

7.1 View Live Image
Select the image either using the appropriate ndefimoyour device. On an iPhone, tap the pictheg you want to
view and the following live view appears:
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7.2  View Recorded Video
From the front screen, select the arrow to thetrighhe image and the following screen appt

il AT&T 3G 3:10 PM 3 -

FEW RSl W ilfrilh

www.demoip.com/vid... G

Back Today Yesterday All

Previous Page

10/6/2010 11:38:37 AM

10/6/2010 11:40:00 AM

10/6/2010 11:41:09 AM

On this screen, you can select recordings from Yodasterday, or All available recordin
Select the recording that you want to view anddineice will then play that vide

. < [ |
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8 Appendices

8.1 Installing Monitor Station
8.1.1 Minimum Requirements

Running one instance of the Monitor Station onghme machine as the IP Server will used approxiynaéd MB
of memory and 30-50% of the CPU. For this reagenrecommend that the Monitor Station be instatiec
separate machine from the IP Server. The diskirements for Monitor Station are minimal, 100 MBhe total
memory required for the Monitor Station is depenidenseveral factors, most notably the number oferas to be
viewed as well as the method of compression. Wemenend a minimum of 1 GB memory for the Monitor
Station. If you are using H.264 or MPEG4 compi@ssihe memory requirements for the Monitor Statimmease
because CPU is required to decompress the ima@esgiously, if you view more compressed images, wilineed
more CPU.

Another factor in running the Monitor Station isr@t Show. The Monitor Station uses a video camepo called
Direct Show to display full resolution images.thé client PC’s graphics card supports Direct S{@war higher),
the Monitor Station will use this and not the PCBU for displaying the images. If the PC’s graphiard does not
support Direct Show, the PC compensates for thigdilyg the CPU. Another factor in

8.1.2 Installing Monitor Station
Browse the CD and run the Setup.exe.

On the License Agreement screen click “I Agree"@ancel”
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Monitor Station Install - Use this option if you@hdy have IP Server installed and only want thaikéo Station.
This process takes approximately 1 minute.
Once installed, the Monitor Station icon will appea your desktop.

Click on the icon and the Monitor Station systemgitowill appear.
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8.2  Monitor Options

There are many ways to customize each Monitor@tatistall depending on the requirements of théviddal

user. Different users will have different waystttieey wish to view their live and recording vide®o set options
for the Monitor Station, go to the Options at tltbm of the list of Tools.

When Options is selected, the following screen appe

8.2.1 General Tab

Exit Confirmation — When this is checked, the systeill request a confirmation prior to shutting dothe Monitor
Station.

Block warning messages — When a camera is no lamgational, the system generates warning messages
prevent a user from seeing these messages, chedioth
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Integrated player initial size — This option séts size of the viewing panel when a recording iscsed from the
left navigation tree. The default is 640 by 486weaver this size can be increased or decreased tiégparameter.

Main View Window Layout
Show Layout — This option actually applies to title bar over the individual live camera views.thfs is not
selected, there will be no title bar. If this édexted, then you can elect to show the Server marttee Camera
name or both in the Title bar.

Show server name — shows the server name onlehedit of the camera pane

Show camera name — shows the camera name onléheatitof the camera pane

Force Aspect Ration - By default, the picture intekyout takes the maximum allowable space. Hewexou
have the option of preserving the proper aspeitt. rédit the aspect ratio is preserved, then théupgcwill retain the
correct aspect regardless of the size and shae efewing window.

Use Direct X Display

Double Click Expands Camera — This option gives ymuability to specify whether a single or doutliek is
required to expand the camera in the left navigatiee to show recordings. If Double Click is stdel, then a
single click on the camera name merely shows theeca in the viewing panel.

On Screen Controls
PTZ Cameras

On Screen PTZ
Overview window
None

Use Direct X

Standard Cameras

Overview Window or None — This option governs leitk to zoom and picture within a picture functiity. If
the Overview Window is checked, then the functidapatill be present on the live camera view. Ifstunchecked,
then this functionality will not be present.
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8.2.2 Tools Configuration

Normal Operation vs. Low bandwidth mode vs. Veny lmandwidth mode

These options relate to how the video is streaméle client and allow the streaming to be sehahelient
(Monitor Station) individually. These options atependent also on the server settings for the tegeln the
Advanced tab of the Server Configuration (See SahghConfiguration Manual), you can set the Setwétigh
bandwidth, Low CPU or Low bandwidth, High CPU.Lbw bandwidth/High CPU is selected at the serveelieall
images will be streamed as compressed and thengptichis Tools Configuration are not applicabtéowever, if
High bandwidth/Low CPU is selected, images are madisnstreamed at full MJPEG (uncompressed). Tloggi®ons
under Tools Configuration can then be set at aivighaial client (Monitor Station) level. For insteg, you may
have some clients that have very good connectarity thus you want to stream at Normal which witicsall
images as uncompressed MJPEG. But you may have slients with a medium or poor quality connectonl
thus you want to stream compressed images. Theralite between Low bandwidth mode and Very Log
bandwidth mode is somewhat subtle. In Low bandwidbde if you are viewing multiple images on a eari will
compress those images but if you switch to a simgégye it will send that image as uncompressed/elty Low
bandwidth mode, all images will be compressed gas of whether you viewing multiple or a singteage.

Downsample Playback — This option allows for faskewnload and playback of recordings. If it isseééd, then
the software will downsample the recordings as #eybeing downloaded. Downsampling (or "subsargpiis
the process of reducing the sampling rate of aasign

Creating Clips
Enable Watermark — places a watermark on all cdedtkeo clips
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Force Motion JPEG format — All clips will be credtim Motion JPEG format. This ensures that theylobaread by
most available off the shelf players

Mini toolbars
These options set the parameters of the Mini tosl@ycle Layouts and PTZ Controls
Cycle Layout Time controls the time interval betwegcles for the Cycle Layout mini tool bar

PTZ cycle time controls the cycle time for the PTi@l bar when the cycle button is selected orPthg
tool bar.

Layouts cycle through current server — This optidmes which cameras will cycle through on the @ylchyout
mini tool bar. If this option is selected, thediview will cycle through the cameras on the sel@server. Ifitis
not selected, then the live view will cycle througle cameras on all servers that are connectdustdonitor
Station.

Mini tool bars always on top — If this option idesgted, then when you utilize either the Cycle Latyor PTZ mini
tool bar, the tool bar will always appear on toghaf current window.
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8.2.3 Live Window

Allow Multiple Live Windows — Allows the user toitiate multiple live windows at the same time. Byht
clicking on the camera and selecting Live Winddwe tiser can create live windows for multiple carseréthis
box is checked, then the user can only have oeepldpup open at once.

Block live windows pop-ups — Live windows can bets® any user that is currently logged onto Mon&tation
(right click on camera and then select Send)hiff bption is selected, then the user will not rezany of those
Live Windows.

Live Window Always on Top - If this option is seted, then the Live Window will always appear on tany
open Window.

Pause Live Display when Live Windows Launchesth#f user wishes to pause the main display windoerveh
live window launches, check this option. This optivould be helpful for people performing singleksiand
reducing the bandwidth usage.

Integrated Facility Map - By default, the facilityaps overlay the viewing panel, i.e. they are sinib a popup live
window. If you wish to have the facility maps igtated into the viewing panel (not a popup), chibik box.

Layout tour cycle time — This option sets the cytalee (time between changes in camera) if layoutd are being
utilized.
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Rules Manager Triggered Options

The Rules Manager provides the ability to set iggér events and automatic resulting actions. istance, when
motion is detected on a particular camera, theegystutomatically sends messages, instant replahasges the

live view to that camera. However, for some usgos, may want to block these types of actions. oklike
appropriate box to block the following types ofjgered events:

Popping Messages Instructions
Switching main layout

Launching instant replay window

8.2.4 Audio

Audio notification on motion — This option givesthser the ability to specify if there will be amydio notification

on motion in a camera. You have the option ofounsl, the default system beep, or you can load gaur
notification sound.

Audio notification on tasks - In some situationdes have been created that specify that an audification will

be generated based on some predetermined setrafewou can elect to have no sound, the defgstem beep or
you can load your own custom notification sound.
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8.2.5 Startup

Since different users may have different requireé@nterms of their usage of the Monitor Statitis tab allows
customization of how the Monitor Station appearstamtup. You may have some users that only vieswlideo
and therefore do not need to see the left navigdtee. You may have some users that only waviets the
facility maps or even a particular facility map.

Starting Layout — This option governs which layuwiilt appear on the startup. Select from the lfdagouts or
select a custom layout.

Hide archive tree on startup — Hides the left natiam tree

Launch facility map on startup — When this optisrchecked, then the designated facility map israatizally
launched at startup.

Auto Upgrade — When this option is checked, whenMlonitor Station is launched, the system will intiagely
compare the software version of the Monitor Statidth the software version of the IP Server thas itonnected
to. If the system detects that IP server is tatex release of the software than the Monitori@tathen it will
upgrade the Monitor Station is the same releaseés dption is useful for ensuring that all instasoé the software
are on the most current release of the software.
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9 Technical Support Options

Your registered Video Insight product includes a oe year software maintenance and technical supportign
that begins on your purchase date. You can contadtideo Insight’s technical support staff by phone oby e-
mail to receive one-on-one support when you are eggencing issues or have questions.

Online: www.video-insight.com/support
Email: support@video-insight.com
Call: 800-513-5417
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